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Welcome to PrintShop Mail® Connect, the new and highly dynamic document composition solution from
Objectif Lune that allows you to create fully personalised business correspondence across a range of
output types.
Key aspects of PrintShop Mail® Connect include the following:


Designer – design tool for creating print and email communications



Output – advanced output and print stream handling across industry-standard print formats



Print Manager – for handling IPDS output

Installing PrintShop Mail® Connect:
Full details on installing and licensing PrintShop Mail® Connect 1.2.* can be found in the online help in
the installer. Note that PrintShop Mail® Connect 1.2.* comes with a 30 day trial license by default.

64 Bit Version Only
PrintShop Mail® Connect 1.2.* is available as a 64 Bit version only.
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1. Performance Improvements
Print output performance has been further improved in Version 1.2.1. This is particularly the case
for PostScript (and VPS/PPML) and PCL output streams.
The biggest performance gains are to be found in print output workflows where a pre-existing print
file is used as an input. Not only has the job processing been dramatically improved (some jobs are
up to 10 times faster!), but the resulting output file is generally much smaller as well.

Specific improvements include:


Refactoring internal Connect technologies has improved program efficiency, leading to
improved performance for all workflows. SHARED-34434/34440



Improved performance for jobs based upon processing pre-existing print files
(AFP/PCL/PDF/PS) as input. (SHARED-34349/34492)



Improved PCL output performance through caching of resources. These improvements are
most apparent when creating multiple output files from the one job. (SHARED33889/34537/34577)



Considerable speed improvement in jobs using AFP files as background images. (SHARED34337)

2. Stability Improvements
Improved stability via more efficient handling and cleaning of Connect internal databases. SHARED30295/34687

3. Simplified logging.
Debugging information has been moved into a separate log file to simplify problem diagnosis.
(SHARED-34546)

4. OMR barcode implementation improved.
OMR style barcodes can be added to pages using the Print Wizard. In duplex jobs these barcodes
were only added to the front page. The implementation has now been enhanced and the barcode
will now be replicated on the reverse side as well, in duplex output. (SHARED-34111)
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1. IPDS Output – PDF containers failed to work in IPDS output due to incorrectly assigned "Hostassigned ID" values. (SHARED-34685)
2. Print Manager – Issues were encountered with some specific IPDS printers, whereby print jobs
would not get sent to printer and would remain stuck in the print queue. (SHARED-34677)
3. Print Manager – Errors were encountered with some IPDS jobs sent to a TrueProof printer
though the Print Manager. (SHARED-34654)
4. Trial license was set to a non-standard performance setting. This has been fixed and the trial
license now resembles a production license. (SHARED-34798)
5. PostScript Output – PS/VPS jobs which were set to be separated by "Document" or "Document
Set" values would throw error messages. (SHARED-34591)
6. PCL Output – Issues were encountered when outputting PCL to certain printers. These issues
included artefacts being introduced on pages and some pages being missed. This errors were
due to differences in graphics handling on different printers. These errors have been fixed.
(SHARED-34853)
7. Print Output – Issues were encountered with the page counter variable in some circumstances.
These issues have now been resolved. (SHARED-35248)
8. Print Output – Issue with the shadowing effect applied to graphical boxes in PCL, AFPDS and
IPDS output. The shadowing was positioned over the box, rather than behind the box. (SHARED35344/35443)
9. Email Output – Attachments added to Connect email templates via scripting were not selectable
in certain email clients. This was been fixed by changing the email format to mixed multipart
MIME. (SHARED-35561)
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This sections provides some basic tips on getting started with PrintShop Mail® Connect as well as details
on some of the highlights of the application.

1. Opening PrintShop Mail® Connect
After PrintShop Mail® Connect has been installed, it can be opened via the following options in the Start
menu:



Connect Designer - opens the PrintShop Mail® Connect Design Tool



Connect Print Manager – opens the Print Manager tool for scheduling and managing IPDS output



Connect Software Activation – opens the Software Activation tool which allows you to load a
license file and view the terms of the End User License Agreement.



Release Notes – Opens the current version of the PrintShop Mail® Connect Release Notes

Note that in the current version the user interface is only supported in English. Other languages will be
introduced with later releases. However all languages are supported for creating documents.

2. Fast Access to Information
PrintShop Mail® Connect includes an extensive online help system providing detailed information on
most areas of the application. Use the “Help Topics” option in the Help menu or press F1 to access the
home page of the help:

Note that in Version 1.2.*, all calls to the online help from the application will default to the home page
of the help. Context sensitivity will be introduced to the help system in a later release. This menu also
provides access to the PrintShop Mail ® Connect “Welcome Screen” which provides wizards and tips for
setting up templates.
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3. Welcome Screen for Getting Started
When first starting the Connect Designer, a Welcome screen is displayed which helps you to quickly
become acquainted with all of the key areas of PrintShop Mail® Connect:

The screen includes the following:
1. A navigation hub for your existing templates.
2. Fast access to the available template wizards.
3. Handy links to online Connect courses, documentation and user forums
4. Easy access to the Web Activation Manager for activating your Connect license.
5. Links to the release notes for that version of Connect and the associated website
6. “Take a Tour” link to online demonstration videos about Connect
7. “News & Events” box keeping you up to date with the latest from Objectif Lune.

You can navigate back to the Welcome Screen at any time using the following button:
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4. Template Options
The Template options in the “Welcome” screen enable you to:




Create a new Template
Access the available Template Wizards
Open an existing Template

The following page is opened when selecting “Create Template” which allows you to select an Email or
Print context for your template:

9

5. Template Wizards
PrintShop Mail® Connect includes various easy-to-use wizards for setting up basic Email and Print
templates. To access the wizards click on the Browse Template Wizards button:

Selecting one of the options opens a Wizard in which you can set up basic properties for that context.
The following example shows the steps associated with setting up a Banded Email template. The New
Banded Email Action Template wizard allows you to specify the colours of the bands, a logo and the
subject and header text:
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Clicking “Finish” will create the Banded Email template:

6. The Data Model Panel
The Data Model panel allows you to navigate through data records. You can navigate forwards or
backwards using the buttons or enter a number directly in the edit box:
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7. Adding and Deleting Contexts
PrintShop Mail® Connect allows you to add and delete a context from a template via corresponding
options in the Resources context menu:

8. Inserting Structural (HTML) Elements
Structural elements can be inserted directly into templates via correspondingly named options in the
“Insert” menu.









Div
Span
Article
Section
Header
Footer
Nav
Aside
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9. Pie Chart Tool
PrintShop Mail® Connect allows you to set up basic 3-dimensional pie charts:

The Pie Chart tool is called via the following icon in the toolbar:
Or via the Business Graphic option in the Insert menu:

It allows you to specify static or dynamic labels and assign values for each segment:
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10. Bar and Line Charts
PrintShop Mail® Connect supports the insertion of basic Bar and Line charts:

The Bar and Line Chart tools are called via the following buttons in the toolbar:
Or via the Business Graphic option in the Insert menu:

They allow you to specify static or dynamic labels and assign values for each bar or line position:

14

11. Inserting Barcodes
PrintShop Mail® Connect includes a range of 1D and 2D barcode symbologies:

Simply click on the new down arrow next to the Barcode icon in the toolbar to open up a list of available
barcodes or go to Insert|Barcode:

After you have selected a barcode type from the list, the Edit
Script dialog is opened in which you can specify the value of your
barcode.
You can add one-to-many fields for the value of the code by using
the green plus button. Each line in the table allows you to specify
the following:


Prefix – free text field for specifying static information to
prefix the field value



Field – for specifying the required field for the barcode
value from a dropdown list



Format – specifies whether the value should be upper
case or lower case. Leaving the box blank means display
the value as specified in the data



Suffix – free text field for specifying static information
after the field value

Properties Dialogs for Barcodes:
Each barcode type has its own properties dialog. After inserting the barcode into your template, rightclick to open the context menu and select the properties option for the barcode. Different properties
dialogs are displayed depending on the barcode type.
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12. Numbered and Bulleted Lists
PrintShop Mail® Connect supports numbered and bulleted lists via the following buttons in the toolbar:
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13. Tables
Tables are easy to set up in PrintShop Mail® Connect. Various options are available for specifying the
properties of tables.


The Table Formatting dialog includes Height, Corner radius and Display settings as well text
wrapping and positioning options. Other tabs allow Spacing and the Background to be defined:



The Table Cell Formatting dialog contains a Height and Width options and a Vertical Align box
with a dropdown menu containing the alignment options:
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Various “Style” options are available when inserting a table including a “No Style” option:

14. Locale Setting
A “Locale” can be specified under Edit|Locale:

Setting the locale allows the script wizards to be based on one of the following:




The System Locale
An Explicit Locale – choose from a global list in the “Locale” control
Dependent on a database field which is then specified in the “Data field” control

When the locale is based on a data field, the locale will always correspond to the current record.
When the value of the locale in the field has not been specified or is erroneous (e.g., misspelled or
mistyped), the default locale for the Java environment is used.
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15. PreFlight Option
A “Preflight” option is available from the Context menu which allows you to validate the records in your
template against various errors. Any errors found are listed in the “Preflight” dialog along with the
section and record in which they occurred:

The “Preflight” check looks for the following:


Missing shared content e.g., missing snippets, resource file not found etc.



Data integrity – checks each record for workflow errors, currency errors, date errors etc.



Missing fields – references to missing fields in scripts



E-mail – common mistakes such as absolute positioned boxes, use of the transform style, <form>
and <input> elements, background images, missing e-mail subject, invalid e-mail addresses etc.



Integrity of hyperlinks



Load errors



Missing images



Content overflow



Syntax errors



Custom runtime errors and warnings



System-generated runtime errors
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16. Print Wizard
PrintShop Mail® Connect provides a Print Wizard for easily making your output specific settings. Go
File|Print and then select the “Advanced” button in the subsequent dialog to open the wizard:







Select the required “Printer Model” from the dropdown list (dependent on your license)
Specify the “Output Type” e.g., Windows Printer
Select the required “Production Options”
Specify the records to be produced and whether filtering and sorting should be applied
Specify the number of copies and whether they should be collated.

The following pages of the Print Wizard will then depend on the options you have selected on the start
page.
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17. Data Filtering Options
The Print Wizard includes various options for filtering data as shown in the following illustration:

18. Separation Options
Separation options, including page count splitting, can be specified on the following page of the Print
Wizard:
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19. Finishing
The following Finishing options are supported in PrintShop Mail® Connect:


Tray\media selection, cut & stack and n-up



Subset stapling of individual documents, corner stapling of both portraint and landscape
documents; subset booklet printing and saddle stitching with fixed page count signatures



Mixed unstapled and subset-stapled documents



Subset finishing is supported in the output engine.



Stapling can be applied to a complete document with sub sections



Jogging



Slipsheet capabilities in the Printer Definition config



Finishing at document level for PCL, AFPDS and IPDS



Finishing at section level for PS, PCL, AFPDS, IPDS

20. Finishing Options for PostScript® Printers
PrintShop Mail® Connect supports Finishing on a document level for any PostScript® printer:


The Finishing options are governed by a Printer Definition Configuration (PDC) file which must be
loaded in the Advanced settings in the Print Wizard.



The PDC needs to contain all of the finishing settings available to your PostScript® printer.



The PDC provides more power and flexibility than a regular PPD in that it allows the inclusion of
logic and conditional processing and also forms a basis for extending this power to other
datastreams in the future.



The PDC files are created and supplied by the Objectif Lune Support Team. Please contact your
local Support team for more information.



Some example PDC’s are provided as a reference (ol.printerdefinition).

The following shows an extract from an example PDC:
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Why is using a PDC more powerful than a PPD?
Using a PDC provides more power and flexibility because it allows you to:


Gather information about the job as a whole (e.g., the media and finishing settings used, number
of pages, number of documents, etc.)



Conditionally insert commands (e.g., only put a setpagedevice at the beginning/end of a sheet
instead of at each logical page)



Define subset finishing (e.g., perform actions on document, set, segment and job boundaries)



Perform logically related settings in a single command (e.g., all the media-related settings are in
a single insert, avoiding the possibility of specifying one setting but not the other)



A PPD only allows you to select from a list of values (which is usually a closed list) while a PDC
allows you to insert properly encoded arbitrary values (e.g., names, colours, weights of media
which may not be included in a PPD)

What is the relationship between the PDC and the Finishing settings in the GUI?
The PDC enables the Finishing controls in the PrintShop Mail® Connect Designer GUI. It specifies which
Finishing controls set in the GUI will be applied on production of the template.
For example, if you select “Stapled” in the Designer, stapling will only be applied providing it is supported
in the PDC.
In other words, all of the Finishing options are available for selection in the GUI but they must be present
in the associated PDC in order for them to work.
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What about the Override Finishing options in the Print Wizard?
Any “Binding” or “Hole Making” option set in the Designer which is supported by the PDC can be
overridden by the corresponding settings in the Print Wizard:






Specify the style of binding e.g., Ring, Stapled, Glued, Stitched etc.
Specify the location, area and angle of the binding
Specify the number of holes required and the pattern.
Note the the “Section to edit” control is not currently supported

Overriding Finishing in Multiple Sections
Ignore Section level finishing and apply all finishing at a document level
To do this, check the "Ignore section level finishing" checkbox and set the required binding and hole
options. At print time this will apply the specified finishing options to the entire document rather than
applying finishing at individual section levels. For example, if a template has 2 sections and document
level stapling is applied, the pages from both sections will be combined and stapled as one single
document.
Override a combination of document and section finishing
In this scenario, uncheck the "Ignore section level finishing" checkbox and use the “section to edit”
combo box to select the required finishing settings for document and section levels. For example, if you
had a two section template you could apply stapling on each of the sections individually and then apply
ring binding to the entire document. This would result in a ring bound document consisting of two
stapled sections.
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Ignore document level finishing and override section level finishing
In this scenario you would perform the following:
 Uncheck the "Ignore section level finishing" checkbox
 Select document finishing in the combo box and specify "None" for the binding style
 Select the other sections in the combo box and apply the required finishing settings
The result would be a document where the required binding finishing is applied to each section in the
document but no overall binding finishing is applied to the entire document.

21. Media Mapping for PostScript Printers
PrintShop Mail® Connect provides two types of mapping to PostScript printers (Media and Properties)
using the Tray Mapping table in the Printer Settings:



The table has six columns which allow the user to specify any combination of position,
weight, type and colour



At least one of the position, weight, type and colour values must be specified. e.g. the user
could specify a weight of 80 and leave all the other fields blank



Setting the value for a tray on one line will cause that value to be updated on all other lines
in the table that use the same tray name e.g., if there are two media and "tray1" is assigned
to each of them, changing the weight on one line will also change the weight in the other
line. This keeps the trays in sync.



When initialised the table will contain one row for each media and will be populated with as
much available information from the media (e.g. specified weight, type and colour) although
this is limited by the number of trays that are specified in the printerdef.
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For example if the template had 3 media:
media1: weight 80, type unspecified
media2: type letterhead, color white
media3: type unspecified
and the selected printerdef had 2 trays:
tray1: 1
tray2: 2
the table would appear as follows:

Media Tray Position Weight
media1 tray1 1

80

media2 tray2 2
media3 tray1 1

Type

Colour

Unspecified
Unspecified white

80

Unspecified

22. Conditional Selection of Media
In some cases it may be necessary to apply different media for the output depending on the value of a
data field. The Media to be conditionally specified using scripting for the sheet positions in the current
section:


The media is defined for each sheet position in the Sheet Configuration dialog. The following sheet
positions are allowed: first, middle, last, single



Each Media entry in the Sheet Configuration displays a script icon. Click on the icon to invoke a plain
script editor with a script with query selector for that specific section + sheet



The head element of a print section will automatically receive META elements for each sheet



The media can be overriden by setting the content attribute of the given META element.



The content attribute of the META elements will initially be empty i.e., use the media as specified in
the Sheet Configuration dialog.



Media set by scripts are propagated to the Main Editor in Preview and Live mode
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23. PDF Options and Signatures
A PDF Options page in the Print Wizard allows you to make PDF-specific settings. It allows you to select
the required PDF type (PDF, PDFA-1b, PDF-X4 and PDF-VT):

It also allows you to set up PDF signatures for your output. First you must set up a Keystore and add it to
the All Keystores table. To do so, click on the green plus icon to open the following dialog.
Enter a unique name for the keystore and browse to
the required .pfx Personal Information Exchange file.
You must then specify the required Keystore Type
(JKS, PKCS11 or PKCS12).
The Provider is set to SUN by default. Note that this
entry will sometimes fail in Version 1.0.1 and should
be left blank. This is a known issue and will be
addressed in a later release.
You must then enter the password associated with
your certificate and then browse to the required
Properties File i.e., security certificate (format =
.cer).
When you have finished making your settings, click OK to add the Keystore to the table (note that if a
Keystore is assigned to a signature, it cannot be deleted from the list):
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You must then specify the actual PDF signature to be used in the template. Click on the green plus icon
next to the All Signatures box to open the PDF Signature dialog:


Provide a unique name for the
signature and select the Keystore on
which it should be based.



Provide details about the reason for
the signature and the contact person
(can be left blank).



Provide the password for the
specified Keystore (same password
as the previous dialog) plus any Alias.



Set up timestamping if this is
required, e.g., if you wish to use
VeriSign (the Handler setting must
be VeriSign PPKVS or Adobe PPKMS).



Specify whether or not the signature
should be visible in a designated area
in the document.



Click OK when you have finished
making your settings to add the
signature to the All Signatures box.

Any number of signatures can be set up for the template providing that each is based on one of the
specified Keystores. When you now produce your template to PDF, the signature you have set up will be
assigned to your template:
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24. Inserter Options and OMR Settings
The Inserter options and OMR settings are provided on dedicated pages of the Print Wizard:



Specify the required inserter machine in the “Model” box



Select the OMR type and Fold type in the “Options” box, including whether the OMR should be
printed on the front or the back.



Specify any selective inserts



Specify a white background for the OMR and its margins

29

PrintShop Mail® Connect includes a Print Manager tool to enable operators in a print room environment
to print and manage IPDS files generated by Connect. It is installed by selecting the “Print Manager”
option in the PrintShop Mail® Connect setup.
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The general workflow is as follows:


Print Manager can be installed as both a standalone application or in conjunction with the
PrintShop Mail® Connect Designer. After installation, an entry will appear in the Start menu
which allows you to open the Print Manager



The operator sets up a list of available printers in the Print Manager and specifies their
properties e.g., IP address, port number etc.



Three hot folders can be set up for each printer (high priority, medium priority or low priority).



When producing to the hot folders, jobs are processed immediately in order of priority. Jobs in
the High priority folder are processed first, then Medium priority, then Low priority.



The operator monitors the jobs sent to the generic printer queue and drags them to a priority
queue on the required printer



The operator can also drag jobs directly from Windows Explorer to the required printer.



The operator can pause and start a printer and specify a page range for a job.

Full documentation on Print Manager can be found in the PrintShop Mail® Connect online help.
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1. GoDaddy Certificates
When installing Connect offline, dialogs are available in the setup for installing the GoDaddy
certificates. Most users will leave the default settings and click “Next”. In some cases however this
may not work correctly. For this reason users should activate “Place all certificates in the following
store” and then select the “Trusted Root Certification Authorities” as the target certificate store.

2. Available Printer Models
Note that only one Printer Model will appear on the Advanced page of the Print Wizard (Generic
PDF) by default. To view all available models go to “Window|Preferences|Print|Available Printers”
and specify which models you wish to be available on the Advanced page of the Print Wizard. You
can go directly to this dialog by clicking on the browse button next to the selection box in the Print
Wizard.

3. External Resources in Connect
There are certain limitations on how external resources can be used in Connect. For example if you
want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you do not
want to have a copy of the file saved with the template you need to do the following:
1. The resource must be located where it can be accessed by all Servers/Slaves run as users. Failure
to do this will cause the image to appear as a Red X in the output for all documents which were
merged by engines which could not access the file. The job will terminate normally and the error
will be logged.
2. The file must be referenced via a UNC path e.g.,
file:////w2k8r2envan/z%20images/Picture/Supported/JPG/AB004763.jpg
a. UNC paths are required because the services will be unable to access mapped network
drives (Windows security feature).
b. The engine processing the job will look on the local file system for the direct file path
leading to the “resource not found” issue mentioned above.
Important Note: The Designer itself and Proof Print do not use processes that run as services and
they may find local files with non-UNC paths which can lead to the false impression that the
resources are correct.
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4. Colour Model in Stylesheets
In Version 1.2.* the colour model of colours defined in a stylesheet can sometimes change after
editing the stylesheet. This is a known issue and will be addressed in a subsequent release.

5. Online Help Links Point to Introductory Page
Context sensitivity for the online help is disabled in PrintShop Mail® Connect Version 1.2.* meaning
that all links and F1 calls currently point to the introductory page of the help. Context sensitivity will
be re-introduced in a subsequent release of PrintShop Mail® Connect.

6. Image Preview in Designer
If in the Windows Internet settings (Connection Settings -> LAN configuration) a proxy is enabled, but
"Bypass proxy settings for local addresses" is not checked, the image preview service, conversion
service and live preview tab in the Designer will not work and exhibit the following issues:


Images will be shows as 0 size boxes (no red 'X' is displayed)



Live preview does not progress, and when re-activated reports "browsers is busy"

To fix the issue you must check the "Bypass proxy settings for local addresses" option.

7. Encoding
Issues may sometimes be encountered in menus and templates when running PrintShop Mail®
Connect on a non-English operating system. These are due to encoding issues and will be addressed
in a later release.

8. VIPP Output
Some templates set up with landscape orientation are being produced as portrait in VIPP. It can also
sometimes be the case that text and images can be slightly displaced. These are known issues and
will be addressed in a later release of PrintShop Mail® Connect.
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